**Table of Contents**

- **Files Required and Introduction** ................................................................. 3
- **Setting Up for a Flow Chart** ............................................................................. 5
- **Changing the Page Setup (1)** .......................................................................... 6
- **Changing the Page Setup (2)** .......................................................................... 7
- **Changing the Width of the Shapes Window** ................................................... 8
- **What the Flowchart Shapes Mean** .................................................................... 9
- **Creating a Flowchart (1)** ................................................................................ 10
- **Creating a Flowchart (2)** ................................................................................ 11
- **Creating a Flowchart (3)** ................................................................................ 12
- **Creating a Flowchart (4)** ................................................................................ 13
- **Creating a Flowchart (5)** ................................................................................ 14
- **Adding Connecting Arrows to Flowchart Shapes** .......................................... 15
- **Selecting and Moving a Group of Shapes** ....................................................... 16
- **Moving Connecting Arrows** ............................................................................ 17
- **Deleting and Recreating Connecting Arrows** ................................................ 18
- **Reversing Direction of Connecting Arrows** ................................................... 19
- **Adding Text to Shapes** .................................................................................... 20
- **Adding Decision Shape’s Connecting Arrow Text** .......................................... 21
- **Moving Decision Shape’s Connecting Arrow Text** ......................................... 22
- **Changing a Shape’s Size** ................................................................................ 23
- **Adding and Deleting Shapes from a Flowchart** .............................................. 24
- **Adding a Title to the Flowchart** ...................................................................... 25
- **Selecting and Moving a Flowchart** ................................................................. 26
- **Changing the Shapes on the Quick Shape Toolbar** ......................................... 27
- **Accessing the IT Training Exercise Files from your own PC/Laptop** .............. 28

---

These session notes are available in alternative formats on request.  
For further information please contact Chris Horton in Computer Centre Room 108  
(01784 41 4025, c.horton@rhul.ac.uk)

© Royal Holloway and Bedford New College 2014. All Rights Reserved
FILES REQUIRED AND INTRODUCTION

Files Required
No files are required for this session.

Introduction
This session considers how you can create Flowcharts using Visio 2010 and includes:

- How to create and modify the Flowchart
- How to add and modify connecting arrows between the different shapes
- How to add text to the Flowcharts’ different shapes
- How to include the decision text to Decision shapes
- How to add a centred main heading

By convention, Flowcharts are generally laid out with the flow going either from left to right, or from top down.

In this session we will create a Flowchart that uses the left to right convention and documents the process of receiving credit card orders from customers.

A completed diagram of this Flowchart is included on Page 4.
Credit Card Orders Flowchart

1. Credit Card Order Received
2. Instigate Order in Order System
3. Check Credit Card Date is Valid
   - Yes: Validate Credit Card
   - No: Customer Needs To Select different Payment Method
4. Validate Credit Card
   - Yes: Credit Card Authenticated
   - No: Customer Needs To Select different Payment Method
5. Customer Needs To Select different Payment Method
6. Orders Database
7. Order Completed in Order System
8. Order Complete
9. Customer Receipt Sent via e-mail
SETTING UP FOR A FLOW CHART

To begin creating a Flow Chart you need to first display a new Drawing Window. You can then add the different Flow Chart shapes to this by either selecting them from the Shapes Window on the left, or by using the Quick Shapes facility.

Follow these steps:

1. To begin creating a Flowchart:
   - If the Choose a Template window is not displaying:
     - Click on the File tab at the left of the Ribbon.
     - Click on New towards the centre of the menu.

2. Double-click on Basic Flowchart (Metric) at the top left of the Choose a Template Window.

3. A new Drawing Window, complete with alignment grid, displays in the main part of the screen.

4. The Shapes Window displays on the left of the screen, showing the Flowchart options that you can use.

5. We will begin by saving this to your (Y:) drive:
   - To begin click on the File tab at the top-left of the screen.
   - Then select [Save As] to open the Save As dialogue box.
   - If necessary scroll down in the left-hand panel to display the list of available drives.
   - Click on your (Y:) drive in the list to select the drive and display its contents in the right-hand panel.

6. In the File name: panel enter the file name for this flowchart, which is:
   - Test Flowchart.Vsd
   - Click on [Save] to save the file to your (Y:) drive.
CHANGING THE PAGE SETUP (1)

Before beginning to create a Flowchart it is useful to setup the Page size. This also enables you to select whether the page is to be Portrait or Landscape, and whether the drawing is to be actual size or to scale.

Follow these steps:

1. Before beginning ensure that you have completed the previous page.

2. We will begin by setting up the printing page size to be A4 Landscape with no gridlines: Click on the Design tab towards the left of the Ribbon.

3. Click on the Dialogue Box Launcher arrow at the bottom right of the Page Setup group at the left of the Ribbon.

   The Page Setup dialogue box displays.

   Ensure that the Print Setup tab is selected then, in this case, ensure that:
   
   - A4 210 mm x 297 mm paper size is selected in the panel below the Printer paper heading
   - The Landscape option under the Printer paper heading is selected
   - The Adjust to option is selected under the Print zoom heading, and that it is set to 100%
   - The Gridlines option under the Print heading is not selected, which prevents the alignment gridlines from printing

4. 

   ![Image of Page Setup dialogue box]
CHANGING THE PAGE SETUP (2)

Follow these steps:

1. Before beginning ensure that you have completed the previous page.

2. We will now set the screen display to enable the page to expand:
   Click on the **Page Size** tab.

3. Then, in this case, ensure that the **Let Visio expand the page as needed** option under the **Page size** heading is selected.

   **Note:** If you wish to keep the flow chart to a particular page size, e.g. A4, click on the **Pre-defined size:** option box so that it displays a check mark.
   Then select the page size required from the second panel below it.

4. Click on the **Drawing Scale** tab.

5. Then, in this case, ensure that the **No scale (1:1)** option under the **Drawing scale** heading is selected.

   **Note:** If you wish to select a scale click on the **Pre-defined scale:** option button so that it displays a check mark.
   Then select an appropriate scale from the second panel below it.

   Alternatively, to specify your own scale click on the **Custom scale:** option button so that it displays a check mark.
   Then enter an appropriate scale in the panels below it.

6. When you have finished click on **[OK]** to close the dialogue box and apply the changes.
CHANGING THE WIDTH OF THE SHAPES WINDOW

The Shapes Window that displays at the left of the screen can be modified to display the Flowchart shapes in either a single or double column.

To change this from one width to the other you just need to drag the Window’s border to the required size.

Follow these steps:

1. Before starting ensure you are viewing the blank Drawing Window.
2. We will now examine how to change the width of the Shapes Window at the left of the screen.
3. To begin, point to the border between the Shapes Window and the Drawing Window.
   When the cursor changes to a double headed arrow you can drag the border to:
4. The left to make the Shapes Window display a single line of shapes.
   The right to make the Shapes Window display a double line of shapes.
5. In this case ensure that the Shapes Window is displaying a double line of shapes.

![Shapes Window Diagram]

![Shapes Window Diagram 2]
# What the Flowchart Shapes Mean

## Most Frequently Used Options

<table>
<thead>
<tr>
<th>Shape</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Start/End</td>
<td>Normally inserted at the start and end of the process. The start shape often includes a relevant name for the process being charted.</td>
</tr>
<tr>
<td></td>
<td>Process</td>
<td>Used to show a process, activity or task.</td>
</tr>
<tr>
<td></td>
<td>Data</td>
<td>Used to indicate inputs to and outputs from a process. Often referred to as an I/O shape.</td>
</tr>
<tr>
<td></td>
<td>Decision</td>
<td>Used to show choices (e.g. yes/no or true/false) in the process flow. Data enters one corner and exits from one of the others depending on the selected outcome.</td>
</tr>
</tbody>
</table>

## Less Frequently Used Symbols

<table>
<thead>
<tr>
<th>Shape</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Subprocess or predefined process</td>
<td>Used to reference a separately named process that (often) contains multiple steps. The Subprocess being referenced should be readily understood by the reader, or covered by an accompanying process chart.</td>
</tr>
<tr>
<td></td>
<td>Document</td>
<td>Used to show the production of a document, e.g. invoice or report.</td>
</tr>
<tr>
<td></td>
<td>Database</td>
<td>Often used to refer to a storage on a hard drive. Sometimes used to refer to an actual database.</td>
</tr>
<tr>
<td></td>
<td>Stored Data</td>
<td>Used to indicate either the input or output of stored data.</td>
</tr>
<tr>
<td></td>
<td>(Visio: Custom 1) Manual input/output</td>
<td>Used to indicate information or material that is entering or leaving the process. Often used so indicate that the user needs to enter data via a keyboard.</td>
</tr>
<tr>
<td></td>
<td>(Visio: Custom 2) Manual operation</td>
<td>Used to show a non-automated process. E.g. where a user needs to manually perform an operation.</td>
</tr>
<tr>
<td></td>
<td>(Visio: Custom 4) Preparation</td>
<td>Used to show a process that involves preparation, e.g. a setting-up operation.</td>
</tr>
<tr>
<td></td>
<td>On-page reference</td>
<td>Used to show a jump from one point in the process to another. Often used to avoid crossing shapes with a flow line. A corresponding On-page reference shape must be included on the page, and both labelled with a capital letter (e.g. A, B, ZZ) to show the matching points.</td>
</tr>
<tr>
<td></td>
<td>Off-page reference</td>
<td>Used to refer to details included on another page, e.g. the continuation of a process. The (e.g.) page number should be included within the shape to show the reader where to look.</td>
</tr>
<tr>
<td></td>
<td>(Visio: Custom 3) Card</td>
<td>No longer used.</td>
</tr>
</tbody>
</table>
CREATING A FLOWCHART (1)

There are two ways to add process shapes to a Flowchart; you can either drag them into place from the Shapes Window, or once one has been added, you can use the Quick Shapes facility. We will begin by adding two shapes by dragging them into place.

Follow these steps:

1. Before beginning ensure that you have completed the previous setting up pages.

2. To explore how a Flowchart can be created we will now produce one to document the process of a customer paying for an online order via a credit card (see diagram on page 4).

3. To begin, drag the Start/End (oval) shape from the Shapes Window onto the top left of the Drawing Window. This should be positioned so it is 1 alignment square from the left and 8 from the top of the Drawing Window.

4. To now add the first Process (Instigate Order in Order System):
   Drag the Process (rectangle) shape from the Shapes Window to the right of the Start/End shape.

5. To add the connecting arrow between these two shapes:
   Point to the Start/End (oval) shape so that it displays four blue arrows around it.

6. Click on the right-facing (oval) shape so that it displays four blue arrows around it.

7. Click on Save on the Quick Access Toolbar at the top left of the window to save the changes you have made.
**CREATING A FLOWCHART (2)**

In addition to dragging Shapes from the Shapes Window, you can also add shapes by using the Quick Shapes menu. To use this you need to have already added a shape to the Drawing Window.

You can then select the four most commonly used flowchart shapes (currently End/Start, Process, Subprocess or Decision) by pointing to one of the blue triangles that display when a shape is pointed to.

**Follow these steps:**

1. Before beginning ensure that you have completed the previous page.

2. To examine how to use the Quick Shapes menu we will now add a Decision shape to our Flowchart.

   To begin, point to the Process (rectangular) shape you previously added to the right of the Start/End shape.

   Blue triangles will display around its outside edge.

   Point to the right-facing blue triangle.

   When the Quick Shape menu displays click on the Decision (diamond) shape.

   The Decision shape will be added to the right of the Process shape, and a connecting arrow inserted automatically.

3. Now add a Subprocess shape to the right of the Decision shape:

   Point to the Decision shape to display its blue triangles.

   Point to the right-facing blue arrow to display the Quick Shape menu

   Click on the Subprocess shape (rectangle with additional end lines) to add it to the Flowchart.

4. Click on Save to save the changes you have made.
CREATING A FLOWCHART (3)

**Follow these steps:**

1. Before beginning ensure that you have completed the previous page.

2. We will now add a **Decision** shape to the right of the **Subprocess** shape, and a **Process** shape below the first **Decision** shape we created.

   To begin, point to the **Subprocess** shape (rectangle with additional end lines) you previously added.

   Blue triangles will display around its outside edge.

3. Point to the **right-facing** blue triangle.

   When the **Quick Shape** menu displays click on the **Decision** (diamond) shape.

   The **Decision** shape will be added to the right of the **Subprocess** shape, and a connecting arrow inserted automatically.

4. We will now add a **Process** shape to the bottom of the **Decision** shape we have just added:

   Point to the **right-hand** **Decision** shape to display its blue triangles.

   Point to the **down-facing** blue arrow to display the **Quick Shape** menu

   Click on the **Process** (rectangle) shape to add it to the Flowchart.

5. Now drag this **Process** shape so that it is below the centre **Decision** shape:

   Point to the **Process** shape so that its blue triangles display.

   Then click and drag the **Process** shape so that it is **four** alignment squares below the centre **Decision** shape.

6. When the **orange Alignment Line** displays through the centre of the two shapes release the mouse button.

   We will add the missing connecting arrows shortly.

7. Click on **Save** to save the changes you have made.
CREATING A FLOWCHART (4)

Follow these steps:

1. Before beginning ensure that you have completed the previous page.

2. We will now begin creating the final Process shape, along with its three associated shapes.

   To begin, point to the right-hand Decision (diamond) shape to display its blue triangles.
   Point to the right-facing blue triangle.
   When the Quick Shape menu displays click on the Process (rectangle) shape.

3. The Process shape will be added to the right of the Decision shape, and a connecting arrow inserted automatically.

4. To now add a Database shape to above the Process shape you have just added:
   Locate the Database (can on its side) shape in the Shapes Window.
   Then drag this so that it is three alignment squares above the newly added Process (rectangle) shape (see illustration below).
   When the orange Alignment Line displays through the centre of the two shapes release the mouse button.

5. To add the connecting arrow between these two shapes:
   Point to the newly added Process (rectangle) shape so that it displays four blue arrows around it.

6. Click on the top-facing arrow to create the connecting arrow to the Database shape.

7. Click on Save to save the changes you have made.
CREATING A FLOWCHART (5)

Follow these steps:

1. Before beginning ensure that you have completed the previous page. We will continue creating the final Process by adding the Data and Start/End shapes.

2. Locate the Data (slanting rectangle) shape in the Shapes Window. Then drag this so that it is three alignment squares below the newly added Process (rectangle) shape (see illustration below).

3. When the orange Alignment Line displays through the centre of the two shapes release the mouse button. To add the connecting arrow between these two shapes:

4. Point to the newly added Process (rectangle) shape so that it displays its four blue arrows. Click on the bottom-facing arrow to create the connecting arrow to the Data shape.

5. We will now complete the Flowchart’s drawing by adding the Start/End shape that completes the process.

6. To begin, point to the Process (rectangular) shape that you added the Database and Data shapes to.

7. When its four blue triangles display point to the right-facing one.

8. From the Quick Shape menu that displays click on the Start/End (oval) shape. The Start/End shape will be added to the right of the Process shape, and a connecting arrow inserted automatically.

9. Click on Save to save the changes you have made.
**ADDING CONNECTING ARROWS TO FLOWCHART SHAPES**

If, when adding shapes, the connecting arrows are not automatically created you can manually add them by using the blue triangles. When doing this you can either drag the blue triangle to the position on an adjoining shape that you want it to connect, or if the shape is close by, by double-clicking on it.

Follow these steps:

1. Before beginning ensure that you have completed the previous page.
2. We will now add the missing connecting line from the centre **Decision** (diamond) shape to the **Process** (rectangular) shape immediately below it:
   - To begin, point to the **Process** (rectangular) shape that is below the centre **Decision** (diamond) shape.
   - When its four blue triangles display click on the top-facing one.
   - The connecting arrow between the **Process** shape and **Decision** shape will be inserted.
3. To create the connecting arrow between the bottom **Process** (rectangular) shape and top-left **Process** Shape:
   - Point to the bottom **Process** shape so that its four blue triangles display.
   - Click on the left-facing blue arrow and drag it up towards the top-left **Process** shape.
   - As you approach the **Process** shape small blue Xs display at the centre of each side’s border.
4. Continue dragging to the **Process** shape’s bottom blue X.
   - When a small red square displays release the mouse button to create the connecting arrow.
5. Click on **Save** to save the changes you have made.
SELECTING AND MOVING A GROUP OF SHAPES

The flowchart could be considered to be rather unbalanced on the page, as it displays across just the top of the page. One way to possibly improve this is to move the right-hand Process and its associated shapes to below those that are currently to their left.

Follow these steps:

1. Before beginning ensure that you have completed the previous page.
2. To begin we need to select the right-hand Process shape and its associated three shapes: Ensure that the Home tab is selected at the left of the Ribbon.
3. Click on the Select button in the Editing group at the right of the Ribbon. Click on Area Select.
4. Click and drag a selection rectangle around the right-hand Process, Database, Data, and Start/End shapes.
5. Click on the border of the selection rectangle. Then drag the rectangle so that the Database shape is immediately below the Subprocess (rectangle with additional end lines) shape AND two alignment squares up from the bottom.
6. When you have finished click away from the selection rectangle to de-select it.
7. You will probably find that the connecting arrow between the right-hand Decision shape and the newly moved Process shape has changed its position. This will be corrected on the next page.
8. Click on Save to save the changes you have made.
## MOVING CONNECTING ARROWS

Should a connecting arrow become connected to the wrong point of a shape it is easy to reposition it. This is done by dragging to the correct location the small red square that displays when the connecting arrow’s line is selected.

### Follow these steps:

1. Before beginning ensure that you have completed the previous page.

2. We will now reposition the connecting arrow from the bottom **Process** (rectangular) shape to the right-hand corner of the right-most **Decision** (diamond) shape:

3. To begin, click anywhere on the connecting arrow’s line between the bottom **Process** shape and the right-hand **Decision** shape.

4. In addition to small blue squares displaying along the connecting line, small red square display at the connection points with the **Decision** and **Process** shapes.

5. As Flowcharts normally flow from left to right, we need the connecting arrow to the bottom **Process** shape to point to its left side.

   Therefore drag the small red square from the top of the bottom **Process** shape to its left side (where the **Database** shape is currently connected).

   You should see that the connections to the **Database** and **Data** shapes are redrawn to be as they were before the shapes were moved.

6. The connecting arrow that originally went to the right corner of the right-hand **Decision** shape has probably moved to a different corner. To correct this:

   Click on the connecting arrow’s top small red square.

   Drag it to the right and then up to the **Decision** shape’s right corner.

7. Finally, stop the connecting arrow’s line bisecting the **Database** shape’s connecting arrow:

   Click on the blue square at the centre of the connecting line’s horizontal length.

   Drag it up so that it is a minimum of two alignment squares above the **Database** shape.

8. Click on **Save** to save the changes you have made.
DELETING AND RECREATING CONNECTING ARROWS

In addition to re-positioning connecting arrows (see previous page) it is also easy to delete and then recreate them using the four blue arrows that display around the shapes.

Follow these steps:

1. On the previous page we examined how to reposition the connecting arrows. An alternative to this is to delete the connecting arrow and then re-create it. We will now examine how to do.

2. To begin, delete the connecting arrow between the bottom Process (rectangular) shape and the right corner of the right-hand Decision (diamond) shape:
   - Click anywhere on the connecting line between the bottom Process shape and the right-hand Decision shape to display its small blue squares.
   - Press [Delete] on the keyboard to delete the connecting arrow.

3. To recreate the connecting arrow:
   - Point to the right corner of the right-hand Decision shape so that it displays its four blue arrows.
   - Click on the right-facing blue arrow and drag it to the bottom Process (rectangle) shape. When the small red square displays release the mouse button to create the connection arrow.

4. It is likely that the connecting arrow will have connected to the bottom corner of the Decision shape, rather than its right corner. To correct this:
   - Click on the small red square that displays immediately below the Decision shape. Drag the red square to the Decision shape’s right corner.

5. Finally, click on the blue square at the centre of the connecting line’s horizontal length. Drag it up so that it is a minimum of two alignment squares above the Database shape.

6. Click on Save to save the changes you have made.
REVERSING DIRECTION OF CONNECTING ARROWS

If a connecting arrow is found to face in the wrong direction it can be easily reversed, which is frequently quicker than deleting and then recreating it.

Follow these steps:

1. We will now examine how to reverse the direction of a connecting arrow.
   In this case the connecting arrow between the centre Decision shape and the Process shape below it should point down, rather than up. To correct this:

2. To begin, click on the connecting arrow between the centre Decision shape and the Process shape immediately below it. Red squares at each end display to indicate the line is selected.

3. Ensure that the Home tab at the left of the Ribbon is selected.

4. Click on the down-arrow to the right of the Line button in the Shape group towards the centre of the Ribbon.

5. Click on Arrows towards the bottom of the menu that displays.

6. In this case click on the left-facing arrow that is immediately above the currently selected option.

7. Click away from the flowchart to deselect it and view the change.

8. Click on Save to save the changes you have made.
**ADDING TEXT TO SHAPES**

To add text to any of the shapes you just double-click on the shape and then type. If the amount of text is large, the shape will automatically resize to accommodate it.

To change the Font Type and Size use the same method as you would use in Word.

---

**Follow these steps:**

1. Ensure that you have completed the previous pages or have several shapes that you need to add text to.
   
   To see the completed Flowchart see page 4

2. To begin, double-click on the left-hand **Start/End** (oval) shape. An insertion point will display within the shape.

3. Enter a suitable description for the shape, which in this case is: **Credit Card Order Received**

4. Now double-click on the most left-hand **Process** (rectangle) shape to obtain an insertion point.

5. Enter the description of this process, which in this case is: **Instigate Order in Order System**

   Similarly, enter the following descriptions into the remaining top shapes:
   - Centre **Decision** (diamond) shape: **Check Credit Card Date is Valid**
   - Right-hand **Subprocess** (rectangle) shape: **Validate Credit Card**
   - Right-hand **Decision** (diamond) shape: **Credit Card Authenticated**
   - **Process** shape below centre **Decision** shape: **Customer Needs To Select Different Payment Method**

6. Now enter the following descriptions into the bottom shapes:
   - **Database** (can on its side) shape: **Orders Database**
   - **Process** (rectangle) shape: **Order Completed in Order System**
   - **Data** (slanting rectangle) shape: **Customer Receipt Sent via e-mail**
   - **Start/End** (oval) shape: **Order Complete**

7. Click on **Save** to save the changes you have made.
**Adding Decision Shape’s Connecting Arrow Text**

All Decision shapes need to have relevant text added to each of their outputs to indicate the decision being made, e.g. Yes/No, True/False. This is achieved by double-clicking on the relevant corner’s connector line to display a text box.

### Follow these steps:

1. Ensure that you have completed the previous pages or have several Decision shapes that you need to add text to.

   We will now add the decision text to the centre **Decision** (diamond) shape.

2. To begin, double-click on the right-hand connector line for the centre **Decision** shape (Check Credit Card Date is Valid).

   A text box will display within the connector line.

   In this case this is the decision indicating that the date IS valid, therefore type: **Yes**

3. Click away from the text box to enter the text into the connector line.

   Now double-click on the bottom connector line for the centre **Decision** shape (Check Credit Card Date is Valid).

4. This is for the decision where the date is NOT valid, therefore type: **No**

   Click away from the text box to enter the text into the connector line.

   Similarly, double-click on the right side connector line for the right-hand **Decision** shape (Credit Card Authenticated).

5. This is for the decision where the credit card IS authenticated, therefore type: **Yes**

   Click away from the text box to enter the text into the connector line.

   Finally, double-click on the bottom connector line for the right-hand **Decision** shape (Credit Card Authenticated).

6. This is for the decision where the credit card is NOT authenticated, therefore type: **No**

   Click away from the text box to enter the text into the connector line.

7. Click on **Save** to save the changes you have made.
MOVING DECISION SHAPE’S CONNECTING ARROW TEXT

When entering a Decision shape’s text, Visio frequently inserts it at approximately the centre of the connector line. This can easily be repositioned by clicking on the text and then dragging the yellow diamond that displays to the required location.

Follow these steps:

1. Before starting ensure you have completed the previous page.

   The Yes decision text for the right-hand Decision shape (Credit Card Authenticated) would probably be better if it was closer to the actual Decision shape.

2. Therefore, to reposition this text:

   Click on the Yes text on the right side connector line for the right-hand Decision shape (Credit Card Authenticated).

   A yellow diamond will display over the text.

3. Click on the yellow diamond and when the cursor changes to a four-headed arrow drag the yellow diamond to over the connector line close to the Decision shape.

   Important: Ensure the yellow diamond is dropped onto the connector line, as it is possible for it to be dropped on to anywhere on the flowchart.

4. Click on Save to save the changes you have made.
**CHANGING A SHAPE’S SIZE**

Although shapes resize to accommodate larger amounts of text, they can be manually resized, should it become necessary.

**Follow these steps:**

1. Before starting ensure you are viewing the Flowchart.
   
   We will now examine how to manually resize a shape by resizing the left-hand **Process** shape.

2. To begin, display the **Size & Position** floating Task Pane:
   
   Click on the **View** tab towards the centre of the **Ribbon**.

   Click on the down-arrow to the right of the **Task Panes** button in the **Show** group towards the left of the **Ribbon**.

3. Click on **Size & Position**

4. Click on the left-hand **Process** (Instigate Order in Order System) shape to select it.

   The **Size & Position** floating Task Pane will display the current settings for the shape.

   **Note:** To select multiple shapes:
   
   Click on the first shape to be selected.

   Hold down **[Ctrl]** at the left of the keyboard.

   Then click on the remaining shapes to be selected.

   Release **[Ctrl]** when you have finished.

5. To modify the shape’s size it is the **Width** and **Height** settings that need to be changed.

6. In this case highlight the **Height** setting (15 mm) and overtype it with: **25 mm**

   Click away from the **Size & Position** Task Pane to view the change.

7. As we do not need this change, click on the **Undo** button on the **Quick Access Toolbar** at the top left of the window.

8. Then close the **Size & Position** Task Pane by clicking on the **X** at its bottom left-hand corner.

9. Click on **Save** to save the changes you have made.
**ADDING AND DELETING SHAPES FROM A FLOWCHART**

Visio makes it easy to add shapes to your Flowchart; you need to just drag the required shape from the **Shapes Window** into position in your Flowchart.

To delete a Shape you just need to click on it and then press [Delete] on the Keyboard.

**Follow these steps:**

1. Before starting ensure you are viewing the Flowchart.
2. To examine how to add a shape to an existing Flowchart we will now add a Subprocess shape to after the left-hand Start/End shape:
3. To begin, drag the **Subprocess** (rectangle with additional end lines) shape from the **Shapes Window** to between the left-hand **Start/End** shape and the **Process** shape.
4. When a small red square displays either side of the **Subprocess** release the mouse button. Click away from the **Process** shape to view the change.
5. You should see that the Flowchart has been repositioned to enable the new shape to be neatly incorporated into it, and connecting arrows automatically inserted.

As the Flowchart does not require the newly added **Subprocess**, now delete it:

6. Click on the newly added **Subprocess** so that it displays its blue sizing handles.

Press [Delete] on the keyboard.

The **Process** shape will be deleted and the connecting arrow between the **Start/End** and **Process** shapes reconnected.

The left-hand **Start/End** shape is probably a distance away from the **Process** shape. To correct this:

7. To ensure the connecting arrow remains straight hold down the [Shift] key at the left of the keyboard.

With [Shift] still depressed drag the **Start/End** shape so that it is suitably close to the **Process** shape.

Then release the [Shift] key.

**Note:** As Visio 2010 does not include the facility to replace one shape with another, this method of inserting a new shape alongside the one to be replaced and then deleting the unwanted one can be used.

Additionally, before deleting the unwanted shape, any text within it can be copied to the new shape.

8. Click on **Save** to save the changes you have made.
ADDING A TITLE TO THE FLOWCHART

Flowcharts generally need a descriptive heading at the top of the chart. To create one you need to add a Text Box to the place the heading is to appear.

Follow these steps:

1. Before starting ensure you are viewing the Flowchart.
2. We now need to insert a Text Box at the top of the page so that we can add a descriptive heading.
3. To begin, click on the Insert tab towards the left of the Ribbon. Click on Text Box in the Text group towards the centre of the Ribbon.
4. Click at the top left of the gridline area of the page. Then drag down by 3 alignment squares and across to the far-right of the page.
   As the insertion point is already within the Text Box you just need to add a suitable heading. In this case enter: Credit Card Orders Flowchart
5. To format the text so that it is emboldened and larger:
   Click within the text box so that it displays its blue Sizing Handles. Ensure that the Home tab at the left of the Ribbon is selected. Click on the Bold button to embolden the heading. Click on the Increase Font Size button in the Font group sufficient times to enlarge the heading to a suitable size.
6. To ensure that the heading is centred on the page:
   Click within the text box so that it displays its blue Sizing Handles. Ensure that Align Middle and Align Center in the Paragraph group towards the centre of the Ribbon are selected.
7. To reposition the Text Box if it is not suitably positioned:
   Hold down the [Shift] key at the left of the keyboard. Use the Arrow keys on the keyboard to budge the Text Box Up/Down and Left/Right.
8. Click on Save to save the changes you have made.
SELECTING AND MOVING A FLOWCHART

If you need to reposition the entire Flowchart on the page, for example to make it more central, you can do so by first selecting it and then either dragging it into place or by using the keyboard’s Arrow keys.

Follow these steps:

1. Before starting ensure you are viewing the Flowchart.
2. We will now select the entire Flowchart and move it so that it appears centred within the page.
3. To begin, if you cannot see the entire Flowchart click on the **Fit page to current window** button at the bottom right-hand corner of the window.
4. Then ensure that the **Home** tab is selected at the left of the **Ribbon**.
5. Click on the **Select** button in the **Editing** group at the right of the **Ribbon**.
6. Click on **Area Select**.
7. Now click and drag a selection rectangle around all of the shapes that make up your Flowchart.

To now move the entire Flowchart:
- Hold down the **[Shift]** key at the left of the keyboard.
- Use the **Arrow keys** on the keyboard to budge the rectangle Up/Down and Left/Right.
- OR
  - Click on the blue border that surrounds the Flowchart.
  - Then drag it to the required position.
8. Click on **Save** to save the changes you have made.
CHANGING THE SHAPES ON THE QUICK SHAPE TOOLBAR

The four shapes that display on the Quick Shapes Toolbar from the blue triangles can be easily changed should you wish to. As it is the first four shapes in the Shapes Window that display on this Floating Toolbar, by reordering these you can change which shapes display, and their order.

Follow these steps:

1. Before starting ensure you are viewing the Flowchart.
2. We will now examine how to change the shapes that are included on the Floating Toolbar that displays when a shape’s blue triangle is pointed to.
   - To begin, drag the Process (rectangle) shape from the Shapes Window onto a clear area of the Drawing Window.
   - Point to the newly added Process shape so that it displays its four blue triangles.
3. Point to the right-facing blue triangle.
4. When the Quick Shape toolbar displays note the shapes that are displayed are as shown in the illustration below.
5. If you now look at the Shapes Window you will see that the Quick Shape toolbar is displaying its first four shapes, and thus changing these will change the Quick Shape’s options.
6. To examine this now move the Start/End shape to be the first shape:
   - Click on the Start/End shape in the Shapes Window at the left of the screen.
   - Drag the Start/End shape so that it is over the Process shape in the Shapes Window.
   - When the vertical line displays to the left of the Process shape release the mouse button.
7. Now point to the newly added Process shape again so that it displays its four blue triangles.
8. Point to the right-facing blue triangle.
9. Now note that the Quick Shape toolbar now displays the Start/End shape at its top, rather than the bottom.
10. By using this method you can select the four shapes that you use most regularly to be displayed on the Quick Shape toolbar.
ACCESSING THE IT TRAINING EXERCISE FILES FROM YOUR OWN PC/LAPTOP

In order to access the files required to complete many of the IT Training exercises you need to access a shared drive, referred to as the (R:) drive in the notes. These instructions give details on how to connect to this drive, for example from your home, along with details on how you can also set up access to your (Y:) drive. **Important:** If your PC already has an (R:) drive/(Y:) drive you will need to select a different letter in the following instructions.

### Follow these steps:

**Note:** If using a Mac, instructions on setting up Campus Anywhere (VPN) can be found at: [http://www.rhul.ac.uk/IT/CampusAnywhere/](http://www.rhul.ac.uk/IT/CampusAnywhere/)

Instructions on mapping to the (R:) drive and (Y:) drive can be found at: [http://www.rhul.ac.uk/it/faq/itfaqs/mac/mappingnetworkdrive.aspx](http://www.rhul.ac.uk/it/faq/itfaqs/mac/mappingnetworkdrive.aspx)

If working on Campus ensure that you are connected to the network (if using an office computer) or CampusNet (if using a laptop etc.).

**OR**

1. If working off Campus ensure that you are connected to the Internet and that you have connected to Campus Anywhere (VPN).
   **Note:** To obtain instructions on how to set up Campus Anywhere (VPN) visit: [http://www.rhul.ac.uk/IT/CampusAnywhere/](http://www.rhul.ac.uk/IT/CampusAnywhere/)

Display My Computer or Computer. To do this:
   Press the Windows key at the right of the keyboard and with it still depressed press E on the keyboard.

2. **OR**
   Click on Start and then click on Computer at the right of the Start menu.

**To map to the (R:) drive:**

Click on Tools.

3. Select Map network drive to open the Map Network Drive dialogue box.
   Click on the drop-down arrow to the right of the Drive: panel and select R: (or any letter of your choice if that already has an entry, and so already allocated).

   In the Folder: panel enter the mapping for the (R:) drive which is: `\ourdata.rhul.ac.uk\teaching\PCLabs`

4. Ensure that the Reconnect at logon box displays a tick mark. If it does not, click within it so that it displays one.

5. Click on [Finish] to complete the setting up. You should now be able to see the (R:) drive containing the IT Training files.

**To map to your (Y:) drive:**

6. You can map to your (Y:) drive as covered in steps 3, 4 & 5 but note the following:
   a) If your PC already has a (Y:) drive you will need to select a different letter in step 3.
   b) In step 4 the path that you must enter is: `\mydata.rhul.ac.uk\home`

   **Note:** When accessing these drives you may be prompted for your username and password.
   If this occurs you must prefix your username with cc\ For example, if your username is zhaa666 then you must enter cc\zhaa666

7. When finished close the My Computer dialogue box by clicking on its Close button. If a My Computer window is still displaying also close it by clicking on its Close button.